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Abstract

Altered cellular metabolism is a hallmark of many diseases, including cancer, cardiovascular diseases and infection. The metabolic motor units
of cells are enzymes and their activity is heavily regulated at many levels, including the transcriptional, mRNA stability, translational, post-
translational and functional level. This complex regulation means that conventional quantitative or imaging assays, such as quantitative mRNA
experiments, Western Blots and immunohistochemistry, yield incomplete information regarding the ultimate activity of enzymes, their function
and/or their subcellular localization. Quantitative enzyme cytochemistry and histochemistry (i.e., metabolic mapping) show in-depth information
on in situ enzymatic activity and its kinetics, function and subcellular localization in an almost true-to-nature situation.

We describe a protocol to detect the activity of dehydrogenases, which are enzymes that perform redox reactions to reduce cofactors such
as NAD(P)+ and FAD. Cells and tissue sections are incubated in a medium that is specific for the enzymatic activity of one dehydrogenase.
Subsequently, the dehydrogenase that is the subject of investigation performs its enzymatic activity in its subcellular site. In a chemical reaction
with the reaction medium, this ultimately generates blue-colored formazan at the site of the dehydrogenase's activity. The formazan's absorbance
is therefore a direct measure of the dehydrogenase's activity and can be quantified using monochromatic light microscopy and image analysis.
The quantitative aspect of this protocol enables researchers to draw statistical conclusions from these assays.

Besides observational studies, this technique can be used for inhibition studies of specific enzymes. In this context, studies benefit from the
true-to-nature advantages of metabolic mapping, giving in situ results that may be physiologically more relevant than in vitro enzyme inhibition
studies. In all, metabolic mapping is an indispensable technique to study metabolism at the cellular or tissue level. The technique is easy to
adopt, provides in-depth, comprehensive and integrated metabolic information and enables rapid quantitative analysis.

Video Link

The video component of this article can be found at https://www.jove.com/video/56843/

Introduction

An essential cornerstone of cellular physiology is metabolism. Metabolism provides cells with the energy needed for all physiological processes,
delivers the building blocks for macromolecular biosynthesis, and regulates cellular homeostasis with respect to waste products, toxic molecules
and the disassembly and recycling of unnecessary or dysfunctional cellular components. Enzymes catalyze nearly all vital cellular chemical
reactions and therefore are the motor units in the physiology of cells.1,2

The activity of enzymes is tightly regulated at many levels and therefore quantitative enzyme histochemistry and cytochemistry (also called
metabolic mapping) is the preferred method to study enzyme activity in situ. At the transcriptional level, gene expression into mRNA is regulated.
The effect of the regulation of transcription can be determined using quantitative mRNA assays, such as microarrays or direct RNA sequencing,
or qualitative mRNA assays, such as in-situ hybridization which gives information on the (sub)cellular localization of mRNA molecules. This
makes it possible to appreciate relative differences in transcriptional activity between cells. However, the interpretation and validity of these
mRNA assays with respect to metabolic activity is complicated because regulation also occurs at the mRNA level, where sequence and
stability of mRNA molecules are edited after it is transcribed from DNA. This editing regulates protein isoform translation and protein translation
quantity at the ribosomes. In addition, the process of protein translation is controlled and ultimately affects enzyme expression and therefore
activity. The combined effects of the aforementioned regulatory steps can be appreciated using quantitative protein expression assays, such
as Western Blotting or reverse phase protein lysate microarrays, or qualitative protein expression assays, such as immunocytochemistry and
immunohistochemistry, but these techniques fail to incorporate downstream regulatory effects such as post-translational modification of proteins
and the functional regulation of enzymes in their crowded microenvironment. Moreover, the expression of an enzyme may poorly correlate with
its activity, so that activity measurements of a purified enzyme in cell or tissue homogenates or in diluted solutions are widely used for enzyme
activity studies. However, these experiments fail to replicate the influence of a crowded compartmentalized cytoplasm or organelle on the activity
of an enzyme. Furthermore, all aforementioned techniques determine either the quantity or the localization of mRNA or enzyme expression, but
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are unable to give comprehensive information on both of these aspects of enzyme expression, let alone the integration of this information with
enzyme activity determinations.2,3,4

Metabolic mapping allows the appreciation of all of the aforementioned variables that determine the activity of an enzyme. What is more,
metabolic mapping is a form of living cell or tissue imaging with cells and tissues that are kept intact during analysis to generate an almost
true-to-nature situation to generate data of activity of enzymes. It produces images that facilitate both the detailed appreciation of the location
of enzyme activity as well as robust quantification of enzyme activity within a cell or tissue compartment.3,4 The protocols described here for
metabolic mapping of activity of dehydrogenases are based on the laboratory manual of all available enzyme histochemical methods,5 on the
principles of quantitative enzyme histochemistry,6 and on image analysis of quantitative metabolic mapping.4

Dehydrogenases are enzymes that perform redox reactions to reduce canonical cofactors such as NAD+, NADP+ and FAD to NADH, NADPH
and FADH2, respectively. Intact cells or cryostat tissue sections that are not chemically fixed are incubated in a reaction medium which contains,
among other reagents, the substrate and cofactors of a specific dehydrogenase and a tetrazolium salt. Subsequently, that dehydrogenase
performs its catalytic activity and reduces, for example, NADP+ to NADPH. Via an electron carrier, 2 NADPH molecules ultimately reduce 1
water-soluble semi-colorless tetrazolium salt molecule into 1 water-insoluble blue formazan molecule that immediately precipitates at the site of
the dehydrogenase. Therefore, the absorbance of precipitated formazan is a direct measure of the local activity of a dehydrogenase and can be
observed using light microscopy or quantified using monochromatic light microscopy and image analysis. The quantitative aspect of this protocol
enables researchers to draw statistical conclusions from these assays. In addition, this quantification facilitates the determination of in situ kinetic
enzyme parameters, such as the maximal enzyme activity (Vmax) and affinity of a substrate for an enzyme (Km).3,4,5,6

When planning a metabolic mapping experiment, it is important to realize that per experiment, a maximum of fifty glass slides with adhering cell
preparations or tissue sections are recommended to minimize time delays during incubation in order to obtain consistent results. It is possible
to process more slides and/or medium compositions when these protocol steps are carried out cooperatively by more than one experimenter.
Furthermore, some variability exists between experiments. Therefore, identical experiments should be repeated at least 3 times with cytospins
from each cell preparation or sections from each tissue sample and appropriate controls should be included in each experiment. Always prepare
a control incubation medium in the absence of substrate but in the presence of cofactors to control for non-specific enzyme activity staining. The
most representative results are obtained in experiments where different substrate/cofactor concentrations are applied to tissue sections or cell
preparations from the same sample, so that the experimenter can perform analyses of enzyme kinetics using dose-activity curves.

Protocol

This protocol follows the guidelines on the use of human material of the Medical-Ethical Review Board of the Academic Medical Center.

1. Preparation of Cells or Tissue Sections

1. Cells
1. Trypsinize cells from culture dishes using 1 mL of 0.25% trypsin-EDTA for 5 min at 37 °C in a 10 mm Petri dish and bring cells in a

37 °C suspension of 50,000-200,000 cells/mL, depending on the size of the cells.
2. Attach 200 µL of the cell suspension onto microscopy slides using cytospin funnels in a cytocentrifuge at 20 x g for 5 min at room

temperature.
3. Air-dry the cytospins for 24 h at room temperature. This does not affect dehydrogenase activity.5

2. Tissue Sections
1. Extract tissue from patients or animals according to ethical permits. 10 mm3 of tissue is sufficient for multiple experiments.
2. Put the pieces of tissue into small vented 2 mL plastic vials and snap-freeze the vials containing the piece of tissue in liquid nitrogen.
3. Store the vials containing tissue pieces at −80 °C until further processing.
4. Use a gel-like medium called optimal cutting temperature (OCT) to mount the tissue sample on a chuck that freezes down to -20 °C to

-25 °C rapidly, so that water cannot form crystals.
5. Use a cryostat for cutting and first trim the block to the desired level (ideally half the width of a microscopy glass slide, e.g. 5 mm x 5

mm).
6. Upon sectioning, use brushes and an anti-roll plate to prevent the sections from curling upwards.
7. Cut tissue samples into 6-10 µm-thick sections at a slow but constant speed (1 s per section). When a section is correctly cut, it

remains flat on the microtome knife under the anti-roll plate.
8. Pick up 1-3 sections on microscopical glass slides and store at −80 °C until use. The number of sections prepared depends on the size

of the tissue sample and the desired thickness of the sections.

2. Enzyme Histo/Cytochemistry for Soluble Dehydrogenases

1. Preparing Reaction Buffer.
1. Prepare 100 mL of phosphate buffer of the correct pH (see Table 1; every enzyme has an optimal pH at which its activity is the

highest). For example, mix solutions of 0.1 M KH2PO4 (acidic) and 0.1 M NA2HPO4 (basic) until a buffer with the correct pH is made.
2. Weigh 18 g of polyvinyl alcohol (PVA) into the phosphate buffer under a fume hood as PVA is dusty and toxic.

1. Dissolve the 18% w/v PVA in the phosphate buffer at 100 °C by warming the buffer au bain marie (put the glass bottle in boiling
water) and stirring until the PVA is completely dissolved. The solution will be transparent then, with small air bubbles that are
caused by the stirring. It typically requires ~15 min for the PVA to dissolve.
 

NOTE: The 18% w/v PVA in phosphate buffer is viscous and can be transferred to 15 mL reaction buffer tubes using a wide
pipette. Short-term storage of 18% w/v PVA in phosphate buffer should occur at ≥40 °C and long-term storage (up to 2 weeks) at
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≥ 60 °C. 250 µL of 18% w/v PVA in phosphate buffer is typically required for a cytospin preparation, while 500 µL is required for a
tissue section.

3. Prepare tetrazolium salt (nitroBT) solution. For every 1 mL of incubation medium, 40 µL of nitroBT solution is required, consisting of 5
mg of nitroBT (a yellow powder) dissolved in a mix of 20 µL dimethylformamide (DMF) and 20 µL of ethanol, which will be a light yellow
transparent solution.
 

NOTE: Because the stability of nitroBT is the lowest of all necessary reagents, it is recommended to prepare the nitroBT stock solution
last and dissolve the nitroBT into the reaction medium first.

1. Dissolve nitroBT in DMF and ethanol by heating it in a glass vial during a short period of time (~10 s) using a Bunsen burner.
Shake the vial during heating and do not leave the vial too long in the flame to prevent evaporation.

2. Make 10% extra nitroBT solution to allow for the evaporation of DMF and ethanol during the dissolving process.

4. Shield the electron carriers phenazine methosulfate (PMS) or (1-methoxy)-phenazine methosulfate (mPMS), and incubation media
containing m(PMS) from direct light by wrapping tinfoil around the glass storage vial.

5. Prepare reagent solutions according to Table 1 by dissolving them in distilled H2O. Some reagents perish rapidly, so prepare them as
shortly before the experiment as possible. Keep reagent solutions on ice or at 4 °C until use.

6. Prepare incubation media as shown in Table 1 and homogenize the solution after each step by gentle stirring. Avoid the generation of
air bubbles in the incubation medium by stirring continuously and keeping the spatula below the surface of the incubation medium while
stirring.

2. Applying Incubation Medium to Tissue Sections
1. Pre-warm microscopy slides with cytospins or tissue sections attached at 37 °C in an immunohistochemistry incubation chamber for 15

min. Submerge the bottom of the immunohistochemistry incubation chamber with warm water to maintain a constant temperature in the
incubator.

2. Carefully break or saw off Pasteur pipettes at the transition from the narrow to the wide part. Regular Pasteur pipettes are too narrow
to aspirate the viscous incubation medium, so this step is needed to make Pasteur pipettes wide enough for the aspiration of the
incubation medium.

3. Apply 250-500 µL of the appropriate incubation medium to each cell preparation or tissue section on microscopy slides using the wide
part of a Pasteur pipette.

4. Use the pipette tip to spread out the incubation medium evenly. Disregard small air bubbles in the incubation medium, because these
will float to the surface and will not interfere with the enzymatic reaction in the cell preparation or tissue section on the microscopy slide.

5. Incubate the cell preparations or tissue sections on the microscopy slides in a 37 °C incubator (e.g. a tissue culture incubator) for a pre-
specified duration, depending on the enzyme kinetics and its expression in a particular cell preparation or tissue (Table 1). Keep the
lid of the immunohistochemistry incubation chamber closed to maintain a humid environment to prevent the reaction buffer from drying
out.

3. Washing the Microscopy Slides
1. Tap off excess incubation medium on a tissue.
2. Mechanically rinse off the incubation medium from the microscopy slides in 60 °C phosphate buffer, pH 5.3, by moving the microscopy

slides up and down in the buffer. This stops the enzymatic reaction.
3. Wash the microscopy slides by keeping them in 60 °C phosphate buffer, pH 5.3 for 20 min.
4. Mechanically wash the microscopy slides in 60 °C tap water.
5. Wash the microscopy slides by keeping them in 60 °C tap water for 20 min.
6. Let the water and slides cool down by slowly mixing room temperature tap water with the 60 °C tap water over the course of 1 minute.
7. Perform a final mechanical washing step in room temperature distilled water.

4. Enclose the Stained Cytospins or Tissue Sections on Microscopy Slides
1. Pre-warm a slide warmer at 50-60 °C.
2. Carefully dry the back side of the microscopy slides using a paper towel and place them on the slide warmer to dry the top side of the

microscopy slide.
3. When the slides are dry, enclose cell preparations or tissue sections on microscopy slides using glycerol jelly mounting medium and

coverslips.
4. Save the cell preparations or tissue sections microscopy slides in the dark in a refrigerator at 4 °C or immediately proceed with image

acquisition.

3. Image Acquisition

1. Record images with a scientific monochrome CCD camera with sufficient dynamic range (at least 8-bit but preferably 10-bit or 12-bit), fixed
gain and a linear response.

2. Select a proper objective (20X-63X for cytospins and 10-63X for tissue sections).
3. Reduce glare by narrowing the field diaphragm so that it is slightly larger than the field of view.
4. Use monochromatic light by applying a 10 nm wide bandpass inference filter near the isobestic wavelength of the formazan precipitate7 in

combination with an infrared blocking filter (see Materials Table).
 

NOTE: The maximum isobestic absorbance of nitroBT is at 585 nm.
5. Optimize illumination to ensure that the entire grey level range of the camera is used (i.e., set the illumination level so that maximum

illumination is achieved without over-exposing when recording a blank microscope slide).
6. Calibrate measured grey levels to known absorbance (or optical density [OD]) values. To this end, capture grey scale images of at least 10

different steps of a calibration slide or step tablet with known OD values (see step 4.1.1), either commercially available (see Materials Table)
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or measure a custom-made grey scale wedge step tablet by a densitophotometer and use the results to calibrate measured grey values to
known absorbance values.

7. Capture photomicrographs of cells or tissue sections of interest.

4. Image Analysis

1. Before image analysis, calibrate the ImageJ software for absorbance measurements.
1. Measure the absorbance (OD) of photomicrographs of at least 10 calibration areas with known absorbance parameters in the

calibration slide or step tablet with known OD values. In ImageJ, use the Analyze → Measure menu or Ctrl+M hotkey to measure a
selected area.

2. Start the absorbance calibration procedure by going to Analyze → Calibration. Choose function "Rodbard (NIH Image)". In the left
column of the window that opens, the results of grey level measurements from each step of the calibration slide/step tablet performed
in 4.1.1 are already present. If not, copy them from the ImageJ results screen. In the right column, enter each corresponding known
absorbance value as printed on the certificate you received with the calibrated step tablet. Tick boxes "Global calibration" and "Show
plot" and press "OK".

3. For quality control, make sure the R2 of the Rodbard function is >0.99. If it is <0.99, check whether the calibration slides were
photographed and measured correctly and whether the known absorbance parameters were entered correctly.

4. ImageJ is now calibrated until you close the program (hence "Global calibration"). For absorbance measurements, a calibrated ImageJ
session always converts the observed absorbance means to values between 0 and 1, where 0 and 1 are the asymptotes of zero and
full absorbance, respectively.

2. For cytospins, select >100 single cells in a random manner. For tissue sections, select one or more fields of interest of a fixed length and
width in all sections.

1. Project a raster over the photomicrographs to assist in unbiased cell selections. In ImageJ, project a grid over an image via the Plugins
→ Analyze → Grid menu.

2. In ImageJ, use the Elliptical Tool to select single cells, and use the Rectangle Tool to select tissue regions.

3. Measure the absorbance and area of the selected cells or tissue regions. The optical density and area are called "Mean" and "Area" in the
ImageJ results spreadsheet, respectively.
 

NOTE: The total absorbance of a cell or tissue region (if you have selected several tissue regions with different sizes) is equal to the sum of
all separated pixel absorbances. If a cell is imaged by 1000 pixels, then the total absorbance is given by the sum of 1000 absorbances and
the mean absorbance is given by total absorbance/1000. This procedure also avoids distributional error.

4. Determine the average total absorbance of >30 cells or tissue regions from the control slide(s), which contains a sample that was exposed
to control incubation medium in the absence of substrate but in the presence of cofactors. This control absorbance is used to control for
non-specific enzyme activity staining and absorbance artefacts induced by the used microscopy slides, mounting medium, cover slip or
microscope.

5. Subtract the average control absorbance from all total absorbance measurements of samples that were exposed to incubation medium with
the same concentration of cofactor (but different concentrations of substrate and/or inhibitor). This gives the corrected total absorbance of a
cell or tissue region.

6. Statistically compare the average corrected total absorbances using the Student's T-test or one-way ANOVA test, depending on your
experimental design.

7. Formazan absorbance can be converted into enzyme activity (µmol converted substrate per mL per min) using the law of Lambert-Beer: c=A/
(є×d), where c is the concentration of formazan in the reaction medium, A is the measured absorbance in ImageJ after calibration; є is the
extinction coefficient of formazan (16.000 at 585 nm)8 and d is the light traveling distance, which is equal to the average cell thickness or
nominal section cutting thickness (6-10 µm in this protocol).
 

NOTE: After drying, the tissue section thickness decreases ~50% from the nominal section cutting thickness, but this is not reflected in the
calculation above because the nominal section cutting thickness is biologically the most relevant. The average cell thickness and sphere
dimensions of cell preparates adhered to microscopy glass slides can be determined using confocal microscopy or wide-field microscopy, for
which protocols can be found elsewhere.9,10

Representative Results

Several protocols to prepare incubation medium are shown to investigate the activity of a particular dehydrogenase. For each dehydrogenase,
dissolve the listed reagents in the PVA solution while maintaining a temperature of at least 37 °C. The reagents should be dissolved in the order
listed in the table, i.e. nitroBT is always dissolved first and (m)PMS is always dissolved last. Each 5 mg of nitroBT is dissolved in 40 µL mix
(20 µL ethanol + 20 µL dimethylformamide). All volumes are per 1 mL of 18% PVA solution, which can be used to stain ~2 tissue sections or
~4 cell preparations on glass slides. NitroBT, NAD+, NADP+, ADP and substrate solutions should be made freshly. NaN3, MgCl2 and (m)PMS
solutions can be stored at 4 °C for one month. 18% PVA dissolved in phosphate buffer can be stored at 60 °C for 2 weeks. The pH of the 18%
PVA solution can be set using different compositions of the 0.1 M potassium dihydrogen phosphate (KH2PO4) and 0.1 M disodium hydrogen
phosphate (NA2HPO4) buffers. The shown incubation periods provide good starting points, but the optimal incubation periods depend on the
species, the tissue type and the preservation of the tissue. In general, cell preparations should be incubated longer than tissue sections to obtain
a similar level of formazan production.
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Wild-type isocitrate dehydrogenase 1 and 2 (IDH1/2) catalyze the conversion of isocitrate to α-ketoglutarate (αKG) with concomitant reduction of
NADP+ to NADPH in the cytoplasm and mitochondria, respectively. These enzymes have recently attracted interest because IDH1/2 mutations
occur in various types of human cancer, including primary brain cancer (glioblastoma) and colorectal cancer, and offer a unique opportunity to
demonstrate the possibilities of metabolic mapping. IDH1 mutations disable IDH1 wild-type enzyme activity and also induce a neo-enzymatic
activity that leads to the production and subsequent accumulation of the oncometabolite D-2-hydroxyglutarate (D-2HG),11 which is discussed
elsewhere in detail.12 Metabolic mapping experiments showed that NADP+-dependent IDH1/2 activity was significantly lower in colorectal
carcinoma cells with a knocked-in heterozygous IDH1 mutation than in colorectal carcinoma cells that were IDH1 wild-type (Figure 1A). This
difference was quantified by image analysis of monochromatic light photomicrographs (Figure 1B).12

Another illustrating example of metabolic mapping experiments is shown in Figure 2, which is an image of a cryostat section of mouse brain
that was injected with human glioblastoma cells. IDH1/2 is the most important NADPH provider in human brain and its activity is upregulated in
wild-type IDH1/2 glioblastoma, whereas the NADPH production capacity of IDH1/2 is much lower in the brains of rodents.11 Figure 2A shows
the difference between the high NADP+-dependent IDH1/2 activity in human glioblastoma cells and the low NADP+-dependent IDH1/2 activity in
healthy mouse brain. IDH1/2 activity is quantified as µmol NADPH production per mL of tissue per minute in Figure 2B.

The enzymatic reaction of IDH1/2 is relatively straightforward, but lactate dehydrogenase (LDH) is a more complicated enzyme complex. LDH
converts the reversible conversion from lactate to pyruvate with concomitant reduction of NAD+ to NADH or vice versa. The availability of lactate
and pyruvate and the composition of the LDH enzyme complex dictates whether lactate is primarily converted to pyruvate (which is catalyzed
by LDH-B and yields NADH) or whether pyruvate is primarily converted to lactate (which is catalyzed by LDH-A and consumes NADH).13

Metabolic mapping experiments are able to visualize the activity of the LDH-B reaction, but they are "blind" to the activity of the LDH-A reaction
because NADH production does not occur and as a consequence nitroBT is not reduced to formazan. Figure 3 shows the NAD+-dependent LDH
activity (i.e. the conversion of lactate into pyruvate) in human brain sections in the absence of substrate (Figure 3A), in the presence of a high
concentration of lactate (Figure 3B), in the presence of 6 mM lactate (Figure 3C) and in the presence of a low concentration of lactate and a
higher concentration of pyruvate (Figure 3D). The results of these experiments illustrate metabolic mapping adequately captures that the NAD+-
dependent LDH activity in tissue sections depends on the availability of lactate and pyruvate in the reaction medium.

Figure 1. NADP+-dependent IDH1/2 activity of human colorectal carcinoma cells. (A) Representative monochromatic light
photomicrographs of HCT116 human colorectal carcinoma cells after staining for NADP+-dependent IDH1/2 activity against 1-10 mM
isocitrate and 0.8 mM NADP+. Scale bars = 50 µm. (B) A quantification of the absorbance of blue formazan produced from nitroBT by NADP+-
dependent IDH1/2 activity per cell is shown with the use of monochromatic light in (A) and image analysis. Abbreviations: IDH1WT/WT, isocitrate
dehydrogenase 1 wild-type; IDH1WT/MUT, isocitrate dehydrogenase 1 mutated. Please click here to view a larger version of this figure.

Figure 2. NADP+-dependent IDH1/2 activity of human glioblastoma samples. (A) Representative photomicrograph of a mouse brain section
containing healthy mouse brain (h) and a human glioblastoma tumor xenograft (t) after staining for NADP+-dependent IDH1/2 activity in the
presence of 0.8 mM NADP+ and 2 mM isocitrate. Scale bar = 200 µm (B) Enzyme activity quantification of areas of mouse brain (h) and human
glioblastoma xenograft (t) shown in (A) using the law of Lambert-Beer. Error bars represent standard deviations. Please click here to view a
larger version of this figure.
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Figure 3. NAD+-dependent lactate dehydrogenase (LDH) activity of human brain samples. Representative photomicrographs of serial
sections of human brain samples after staining for NAD+-dependent LDH activity (A) against control conditions (in the absence substrate and
pyruvate, 3 mM NAD+ only) (B) against 150 mM lactate in the absence of pyruvate (C) against 6 mM lactate in the absence of pyruvate and (D)
against 6 mM lactate in the presence of 18 mM pyruvate, the competitive product inhibitor of the lactate-to-pyruvate reaction. Scale bar = 200
µm. Please click here to view a larger version of this figure.

Enzyme: G6PDH LDH SDH MDH IDH1 IDH2 IDH3 6PGD GDH

PVA 18%
in 100 mM
phosphate
buffer

1 mL; pH =
7.4

1 mL;  pH =
7.4

1 mL;  pH =
8.0

1 mL; pH =
7.4

1 mL; pH =
7.4

1 mL; pH =
7.4

1 mL; pH =
7.4

1 mL; pH =
8.0

1 mL; pH =
8.0

5 mM
NitroBT

5 mg/40 µL
mix

5 mg/40 µL
mix

5 mg/40 µL
mix

5 mg/40 µL
mix

5 mg/40 µL
mix

5 mg/40 µL
mix

5 mg/40 µL
mix

5 mg/40 µL
mix

5 mg/40 µL
mix

5 mM NaN3 10 µL 10 µL 10 µL 10 µL 10 µL 10 µL 10 µL 10 µL

5 mM MgCl2 10 µL 10 µL 10 µL 10 µL 10 µL 10 µL

3 mM NAD+ 10 µL 10 µL 10 µL

0.8 mM
NADP

10 µL 10 µL 10 µL 10 µL 10 µL

2 mM ADP 10 µL

substrate 10 mM
glucose-6-
phosphate

150 mM
lactate

50 mM
succinate

100 mM
malic acid

2 mM
isocitrate 

2 mM
isocitrate

2 mM
isocitrate

10 mM 6-
phospho-
galactonate

10 mM
glutamic acid

0.32 mM
mPMS 

10 µL 10 µL 10 µL 10 µL 10 µL

0.2 mM
PMS 

10 µL 10 µL 10 µL 10 µL

Incubation
duration

5 min 30 min 60 min 60 min 30 min 30 min 30 min 10 min 30 min

Table 1. Schematic overview of the metabolic mapping protocol for dehydrogenases.  Abbreviations: ADP, adenosine diphosphate;
(m)PMS (methoxy)-5-methylphenazinium methyl sulfate; nitroBT, nitro tetrazolium blue chloride; G6PDH, glucose-6-phosphate dehydrogenase;
LDH, lactate dehydrogenase; SDH, succinate dehydrogenase; MDH, malate dehydrogenase; IDH, isocitrate dehydrogenase; 6PGD, 6-
phosphogluconate dehydrogenase; GDH, glutamate dehydrogenase.
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Discussion

Research on cellular metabolism is currently experiencing a renaissance because researchers realize now that metabolic effects are crucial for
the pathogenesis and treatment of many diseases.1 Furthermore, metabolic research is aided by an increasing availability of techniques that
provide this field of research with more tools than ever, including mass spectrometry, radioisotopic labeling and nuclear magnetic resonance
spectrometry. Metabolic mapping is by no means a novel technique, but its capacity to give integrated information on the activity of enzymes in
an almost true-to-nature situation makes this technique more relevant than ever.2

The cofactors NAD+ and NADP+ are found in all living cells, which indicates that dehydrogenases arose very early during evolution and have key
roles in cellular metabolism.14,15 Currently, there are 523 enzyme-catalyzed reactions that are classified as dehydrogenases and occur across all
species.16 Theoretically, the activity of all different dehydrogenase reactions can be separately investigated by tweaking the metabolic mapping
protocol described here. Every enzymatic reaction is unique by means of the substrate and cofactors that are needed for its activity. Therefore,
the activity of each enzymatic reaction can be determined using a metabolic mapping experiment with the adequate substrate and cofactors
in the reaction medium. However, some enzyme isoforms differ in their subcellular localization, e.g. one isoform catalyzes a reaction in the
cytoplasm whereas another isoform functions in the mitochondria. A notable example is IDH1 and IDH2, of which the former is cytoplasmic and
the latter is mitochondrial and which are two different proteins encoded by two different genes.11 1-methoxy-5-methylphenazinium methylsulfate
(methoxy-PMS) and 5-methylphenazinium methylsulfate (PMS) can both be used as electron carriers for these experiments. The former does
not pass mitochondrial membranes, the latter does. Therefore, investigations on mitochondrial enzymes (e.g. IDH2) should use PMS whereas
investigations on cytosolic enzymes (e.g. IDH1) should use mPMS.

As with many techniques, variations of this protocol, such as using different types of tetrazolium salts, excluding the addition of PMS and sodium
azide, using an aqueous mounting medium, and varying incubation and rinsing times, do exist and may work equally well. The application of
metabolic mapping with tetrazolium salts is not limited to dehydrogenases. With small modifications to the protocol, it can also be used for the
assessment of the activity of enzymes that function directly upstream of a dehydrogenase in a metabolic pathway. We have previously described
this principle for the glutaminase enzyme,17 which functions directly upstream of glutamate dehydrogenase in the glutaminolysis pathway.18 In
theory, the same principle can be applied to other enzymes that function directly downstream or upstream of a dehydrogenase e.g. aconitase,
which lies directly upstream of IDH2 and IDH3 in the tricarboxylic acid (TCA) cycle. Another simple variation of the concentrations described
in Table 1 is by means of making incubation medium vials with various concentrations of substrate, cofactor and/or inhibitor. This allows the
generation of dose-activity curves as a function of substrate, cofactor and/or inhibition concentration.

Technically speaking, metabolic mapping experiments do not facilitate unbiased observations of in situ enzyme activity, because researchers
have to choose a substrate and cofactor concentration that may not reflect the substrate and cofactor levels that are present in situ. Furthermore,
the use of viscous 18% PVA in the reaction medium serves to keep macromolecules intact, in place and in conformation but prohibits effective
diffusion of low molecular-weight reagents through the reaction medium.3,5 Therefore, the determined enzyme activities in the experiments
described here that use supraphysiological substrate concentrations do not reflect the in vivo situation at a given substrate concentration but are
suitable for intra-experimental comparisons. Thus, the outcome of metabolic mapping experiments is the production capacity (maximum activity)
of an enzymatic reaction in the context of the substrate and cofactor levels that are present in situ. Moreover, the use of various concentrations
of substrate and/or cofactors and multiple samples allows unbiased comparison of the maximum production capacity (Vmax) and affinity (Km) of
an enzyme for a substrate/cofactor in cell preparations, tissues or tissue regions. These parameters are the result of the sum of enzyme protein
expression, post-translational modifications and the effect of a crowded microenvironment on the activity of enzymes. Therefore, metabolic
mapping is still a better reflection of enzyme activity than experiments that determine protein expression or purified enzyme activity in vitro.
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